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Artemis 立ち上げの前に

【注意事項】全角文字は避けてください！

コンピュータのアカウント名に全角の文字（例：内山、ウチヤ
マ）が入っているとAthenaからのデータインポートやフィッ
ティングが実行できない可能性があります。OSのバージョンに
よっては、コンピュータ名が全角文字でもNGです。
*Artemisは C:¥Users¥アカウント名¥Desktop のパスを経由して各フォルダにアクセスするようです。

その場合は、半角の名称で別のアカウントを作って下さい。

データを格納するフォルダも半角の名称で作って下さい。

Artemisには未知のバグが多数存在するため、こまめに保存する
ことをおすすめします。



概要

1. EXAFS解析の流れ
2. Artemisを使用した解析

構造モデルの作成
理論計算結果の比較
カーブフィッティング



EXAFS解析の流れ

Artemis立ち上げ

① Athenaデータ読み込み

② 構造モデルの作成(Atoms)

モデル作成に必要な情報

・吸収元素の種類、吸収端

・結晶構造パラメータ（空間群、座標等）

③ EXAFSの理論計算（FEFF）

・Artemisに予め組み込まれている

④ フィッティングパラメータの作成

⑤ フィッティング実行

⑥ 束縛条件下でのフィッティング

Athenaでデータ処理しておく！

・Background、Baselineの処理

・c(k)(EXAFS振動)の抽出

・c(k)をFT-EXAFSに変換

Atoms: FEFFの実行ファイルを

作成するためのプロフラム

.cif ファイルを入手しておくと

モデル作成の手間が幾分省ける

FEFF: 光電子の散乱過程と

散乱強度を計算するための

プログラム

⑦ 解析結果の保存



Artemis 立ち上げの前に

以降では、この解析パラメータで
フィッティングを実施します



Artemis 立ち上げ

Help > About Artemis から
バージョンを確認できる

*最新版は 0.9.25 です

(2017年2月3日現在)

Data sets Addボタン

Athenaデータ（実験
データ）を読み込む

Feff calculations Addボタン

.cif ファイルを読み込むのに使う

（今回は使いません）

プロットオプションウィンドウ

基本的な使い方は Athena と同じ



Artemis 保存の方法

Save ボタンでも

保存できる

File > Save project as



① Athenaデータ読み込み

File > Open project or data

or 

Ctrl + o

or 

Data sets Add ボタン

GaN.prj を選択 > 開く

GaN.txt を選択 > Import 
selected data

*Add ボタン上で右クリックすると、最近開いたAthenaのプ
ロジェクトファイル一覧が表示され、そこからAthenaのデー
タを読み出すこともできる

*ここはデフォルトでOK



① Athenaデータ読み込み

データウィンドウとプロットウィンドウが新たに立ち上る

Data sets に GaN.txt が追加される

*左クリックするとデータウィンドウが最小化する

*右クリックで名称変更(rename)、削除(discard)ができる



① Athenaデータ読み込み

データウィンドウ詳細

フーリエ変換する範囲

逆フーリエ変換（フィッ
ティング）する範囲

kn.c(k) (n = 1,2,3)のうち、
どのデータをフィットするの
かを選択（複数選択可）

k123: kn.c(k) (n = 1,2,3)をプロット

R123: k123をフーリエ変換したものを
プロット

Rmr: Rと虚数部をプロット

Rk: Rとkをプロット

kq: kとq(逆フーリエ変換)をプロット

Include in fit: GaN.txtの
データをフィッティングする
（☑） or しない（□）

Plot after fit: フィット後、
プロットウィンドウに結果を
表示する（☑） or しない
（□）

Fit background:

Plot with phase correction:

これら2つのオプションの詳
細はDemeterのWebページ
を参照して下さい

通常はチェックを外しておく



① Athenaデータ読み込み

プロットウィンドウ

kの重み付けを指定
k空間を表示

R空間を表示

プロットするデータの種
類を指定

横軸のスケールを指定

Clear: Plotting listをクリアする

Save next plot to a file:

このボタンを押して、上部にあるk,R,qのボタ
ンを押すと保存先を指定するウィンドウが出現
し、該当するプロットが.txtで保存できる

プロットするデータを選択（複数選択可）

右クリックでdiscardを選ぶとlistから削除



① Athenaデータ読み込み

よくやってしまう操作ミス

(A) データウィンドウを × で消してしまった

(B) プロットウィンドウを × で消してしまった

(C) Plotting list からデータを消してしまった

(D) Clear ボタンを押して、Plotting list が真っ白になった

安心してください！ 復旧できますよ！

(A) データウィンドウを × で消しても、最小化されているだけなので、
Showボタンから復帰できます



① Athenaデータ読み込み

よくやってしまう操作ミス

(A) データウィンドウを × で消してしまった

(B) プロットウィンドウを × で消してしまった

(C) Plotting list からデータを消してしまった

(D) Clear ボタンを押して、Plotting list が真っ白になった

安心してください！ 復旧できますよ！

(B) プロットオプションウィンドウのk, R, qのいずれかを押すとプロッ
トウィンドウが復活します



① Athenaデータ読み込み

よくやってしまう操作ミス

(A) データウィンドウを × で消してしまった

(B) プロットウィンドウを × で消してしまった

(C) Plotting list からデータを消してしまった

(D) Clear ボタンを押して、Plotting list が真っ白になった

安心してください！ 復旧できますよ！

(C,D) データウィンドウのこのボタンを押すと、該当するデータが
Plotting listに追加されます



EXAFS解析の流れ

Artemis立ち上げ

① Athenaデータ読み込み

② 構造モデルの作成(Atoms)

モデル作成に必要な情報

・吸収元素の種類、吸収端

・結晶構造パラメータ（空間群、座標等）

③ EXAFSの理論計算（FEFF）

・Artemisに予め組み込まれている

④ フィッティングパラメータの作成

⑤ フィッティング実行

⑥ モデル妥当性の検証

Athenaでデータ処理しておく！

・Background、Baselineの処理

・c(k)(EXAFS振動)の抽出

・c(k)をFT-EXAFSに変換

Atoms: FEFFの実行ファイルを

作成するためのプロフラム

.cif ファイルを入手しておくと

モデル作成の手間が幾分省ける

FEFF: 光電子の散乱過程と

散乱強度を計算するための

プログラム

⑦ 解析結果の保存



② 構造モデルの作成

Feff calculations  Addボタン

右クリック

[---] Open a blank Atoms window

を選択 > OK

Atoms のウィンドウが立ち上る

*.cif ファイルを持っている場合は、左クリック
から、該当する .cif ファイルを選択して読み込
ませる。



② 構造モデルの作成

Atomsウィンドウ詳細

.cif ファイルを持っていれば、
ここから読み込むことも可能

結晶構造情報を入力する

GaNの結晶構造情報

空間群 P63mc (186)

原子座標

Ga: 1/3, 2/3, 0

N: 1/3, 2/3, 3/8

格子定数

a = 3.186 Å

b = 3.186 Å

c = 5.176 Å

α = 90°

β = 90 °

γ = 120 °

*2つ以上のサイトを同じ元素が占有している構造に対し
て用いると、平均のEXAFSを計算する。

例：3種類のTiサイトを有するBaTi2O5など



② 構造モデルの作成

入力例：GaN
名称（実質何でもよい）

XAFSのデータは、GaのK-edge

FEFFで計算するモデルの大きさ
（Gaを原点とする球の直径）

光電子が散乱される最大の距離

（≒最長の結合距離）

入力値より長い距離は計算しない

186 でもよい

*部分置換モデルには、今のところ対応していない。

置換量が微量の場合は、ちょっとした工夫で対応が可能。（例：
GaNに添加した微量EuのEu LIII-edge EXAFS ← 明日の実習で実
施します。）



② 構造モデルの保存
入力後、保存ボタン（フロッピーのマーク）で、この構造モデルを保存してください。

保存名：GaN.inp

一度、.inp として構造モデルを保存しておけば、次回
からは、Open file ボタンで読み出すことができる。



EXAFS解析の流れ

Artemis立ち上げ

① Athenaデータ読み込み

② 構造モデルの作成(Atoms)

モデル作成に必要な情報

・吸収元素の種類、吸収端

・結晶構造パラメータ（空間群、座標等）

③ EXAFSの理論計算（FEFF）

・Artemisに予め組み込まれている

④ フィッティングパラメータの作成

⑤ フィッティング実行

Athenaでデータ処理しておく！

・Background、Baselineの処理

・c(k)(EXAFS振動)の抽出

・c(k)をFT-EXAFSに変換

Atoms: FEFFの実行ファイルを

作成するためのプロフラム

.cif ファイルを入手しておくと

モデル作成の手間が幾分省ける

FEFF: 光電子の散乱過程と

散乱強度を計算するための

プログラム

⑦ 解析結果の保存

⑥ 束縛条件下でのフィッティング



③ EXAFSの理論計算

Run Atoms

FEFFに読み込ませるため
のファイルを作成する

左クリックで実行

タブがFeffに切り替わり、Feff
input file が作成される

Run Feff

FEFFによるEXAFSの理論
計算を実行する（左ク
リック）

吸収原子

散乱原子

吸収端を指定する

K:  HOLE 1      
LI: HOLE 2     
LII: HOLE 3   
LIII: HOLE 4

座標 元素種 中心からの距離

*書式の詳細についてはFEFFのWeb
ページを参照してください

http://leonardo.phys.washington.ed
u/feff/html/documentation.html



③ EXAFSの理論計算

Feff input file を必要に応じて保存する。

Atoms と同様に Save file ボタンで保存できるが、Atoms と 同じ
拡張子（.inp）なので、別名で保存する必要がある。

例）feff-GaN.inp



EXAFS 計算結果の見方

③ EXAFSの理論計算

Degen

多重度（＝配位数）

Reff

結合距離

Scattering path

光電子の散乱過程を表示する

@が吸収元素

Rank

EXAFS振動への寄与

（最も強いpathを100としている）

Type

光電子の散乱過程、散乱回数

Single scattering: 単散乱

GaN

Scatteing path No.1 を平面図にすると。。。

N

N

N

同じ距離にNが4つ

1.948 A

Gaから飛び出した光電子が
Nに1回だけ散乱されてGa
に戻ってくる（Single 
scattering）

e-

e-
＠



[補足]他の散乱パスはどのように記述されているのか？

③ EXAFSの理論計算

一回散乱
(single scattering path)

二行程
(2 legs)

二回散乱
(doble scattering path)

三行程
(3 legs)

三回散乱
(triple scattering path)

四行程
(4 legs)

Ga

Ga

Ga_1 N_1

N_2

Ga_2

Artemisで計算されるR（距離）＝光電子が散乱された距離の ½

１回散乱の R = 結合距離

２回以上の散乱過程のRは、もはや結合距離ではないことに注意



③ EXAFSの理論計算
EXAFS 計算結果をグラフに表示する

表示したい散乱パスを選択（複数選択はCtrlを押しながら）

データウィンドウの

Path list 内に ドラッグ＆ドロップ

表示したい散乱パスを
左クリックで選択

このボタンを押すと、該当する

データがPlotting listに追加



③ EXAFSの理論計算
EXAFS 計算結果をグラフに表示する

それぞれの散乱パスを足し合わせたEXAFSを
表示したい場合は？

追加を確認！



③ EXAFSの理論計算
それぞれの散乱パスを足し合わせたEXAFSを表示する

足し合わせたいパスに☑を入れる



③ EXAFSの理論計算
それぞれの散乱パスを足し合わせたEXAFSを表示する

Actions > Make sum of marked paths and plot in R

or

Alt + Shift + m



③ EXAFSの理論計算
それぞれの散乱パスを足し合わせたEXAFSを表示する

名前をつける ＞OK



③ EXAFSの理論計算
それぞれの散乱パスを足し合わせたEXAFSを表示する

追加を確認！

タブが自動的にVpaths
に移動するが、◁▷ボタ
ン ＆ 他のタブをクリッ

クすれば移動できる

散乱パス足し合わせの注意点

F.T.(cGa-N(k))+F.T.(cGa-Ga(k)) ≠ F.T. (cGa-N(k)+cGa-Ga(k))

それぞれのEXAFS振動をF.T.して

から足す（間違い）
それぞれのEXAFS振動を足して

からF.T.する（こちらが正しい）

http://4.bp.blogspot.com/-CUR5NlGuXkU/UsZuCrI78dI/AAAAAAAAc20/mMqQPb9bBI0/s800/mark_maru.png
http://4.bp.blogspot.com/-CUR5NlGuXkU/UsZuCrI78dI/AAAAAAAAc20/mMqQPb9bBI0/s800/mark_maru.png


③ EXAFSの理論計算
これまでのデータを保存する

File > Save project as

or

Ctrl + s

or 

Save ボタン

→ Artemis-GaN.fpj

Artemisには、未知のバグが多数存在するのでこ
まめに上書き保存することをおすすめします。

動作がおかしくなったら、保存してArtemisを再
立ち上げしてください。使い続けると突然ク
ラッシュします。

内山がこれまでに出会ったバグ（おそらくまだ修正されていない）

 フィッティングを一度も実行せずに保存し、Artemisを立ち下げると、二
度と立ち上がらなくなる。

 Data sets に実験データをインポートした後、削除し、もう一度同じ実験
データをインポートするとフィッティングする際にエラーを起こす。

*バグの出方はOSにも依存します。



EXAFS解析の流れ

Artemis立ち上げ

① Athenaデータ読み込み

② 構造モデルの作成(Atoms)

モデル作成に必要な情報

・吸収元素の種類、吸収端

・結晶構造パラメータ（空間群、座標等）

③ EXAFSの理論計算（FEFF）

・Artemisに予め組み込まれている

④ フィッティングパラメータの作成

⑤ フィッティング実行

Athenaでデータ処理しておく！

・Background、Baselineの処理

・c(k)(EXAFS振動)の抽出

・c(k)をFT-EXAFSに変換

Atoms: FEFFの実行ファイルを

作成するためのプロフラム

.cif ファイルを入手しておくと

モデル作成の手間が幾分省ける

FEFF: 光電子の散乱過程と

散乱強度を計算するための

プログラム

⑦ 解析結果の保存

⑥ 束縛条件下でのフィッティング



④ フィッティングパラメータの作成

フィッティングで求めるパラメータ

S0
2 （多体効果（定数））

rj （距離）

sj (デバイワラー因子)

ΔE0 （kの原点）

※Nj（配位数）は固定

FEFFによる理論計算で求める
パラメータ

Fj(k)（後方散乱因子）

fj(k) （位相因子）

Σj ： 散乱原子に対して足し合わせ
る
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④ フィッティングパラメータの作成

Artemis上での変数を定義する

S0
2 （多体効果（定数））→ amp

rj （距離）→ delr（*FEFFで計算したRからの変位のみを計算）

sj (デバイワラー因子) → ss

ΔE0 （kの原点） → enot

※Nj（配位数）は固定 → N=4

まずは、第一配位圏のGa-N結合に対してフィッティングをかけてみる
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変数に使う文字は何でもよい（a,b,c,a1,b2…）が、プラス（+）、ハイ
フン（-）、アスタリスク（*）、スラッシュ（/）を入れてしまうと、
演算の意味になってしまうので、変数には使わないようにしてください。



④ フィッティングパラメータの作成

Artemisに変数を登録する

S0
2 （多体効果）→ amp

rj （距離）→ delr

sj (デバイワラー因子) → ss

ΔE0 （kの原点） → enot

※Nj（配位数）は固定 → N=4

まずは、第一配位圏のGa-N結合に対してフィッティングをかけてみる

Ga-N結合を選択



④ フィッティングパラメータの作成

まずは、第一配位圏のGa-N結合に対してフィッティングをかけてみる

各パラメータの入力欄内で右クリックするとオプション
ウィンドウが出てくる

guess:

独立なパラメータ

def:

他のパラメータに依存するパラメータ

数式で定義、定数でも可

set:

定数

（数式でも定義可だが，フィッティング初期に計算後
は更新されない）

Skip:

フィッティングで考慮しないパラメータ



④ フィッティングパラメータの作成

まずは、第一配位圏のGa-N結合に対してフィッティングをかけてみる

Guessを選択



④ フィッティングパラメータの作成

まずは、第一配位圏のGa-N結合に対してフィッティングをかけてみる

Guessを選択

パラメータウィンドウが出てきて、登録が完了する

初期値 or 数式入力欄変数

パラメータの種類を選択



④ フィッティングパラメータの作成

まずは、第一配位圏のGa-N結合に対してフィッティングをかけてみる

全てのパラメータを登録する

× で消してしまっても ここを左クリックで復活します

これでフィッティングパラメータの作成は完了！！



EXAFS解析の流れ

Artemis立ち上げ

① Athenaデータ読み込み

② 構造モデルの作成(Atoms)

モデル作成に必要な情報

・吸収元素の種類、吸収端

・結晶構造パラメータ（空間群、座標等）

③ EXAFSの理論計算（FEFF）

・Artemisに予め組み込まれている

④ フィッティングパラメータの作成

⑤ フィッティング実行

Athenaでデータ処理しておく！

・Background、Baselineの処理

・c(k)(EXAFS振動)の抽出

・c(k)をFT-EXAFSに変換

Atoms: FEFFの実行ファイルを

作成するためのプロフラム

.cif ファイルを入手しておくと

モデル作成の手間が幾分省ける

FEFF: 光電子の散乱過程と

散乱強度を計算するための

プログラム

⑦ 解析結果の保存

⑥ 束縛条件下でのフィッティング



⑤ フィッティング実行

まずは、第一配位圏のGa-N結合に対してフィッティングをかけてみる

Ga-N結合のみを切り出す（フィッティングの範囲）

3に☑

Include in fit, Plot after fitに☑

Include path, Plot after fitに☑

Ga-N結合を選択

フィッティングに用いる k の範囲を指定



⑤ フィッティング実行

まずは、第一配位圏のGa-N結合に対してフィッティングをかけてみる

Include path, Plot after fitのチェック
を外す（フィッティングから除外）

Ga-Ga結合を選択



⑤ フィッティング実行

まずは、第一配位圏のGa-N結合に対してフィッティングをかけてみる
いよいよフィッティング！

その前に、保存！！

R を選択

フィッティングを実行



⑤ フィッティング実行

フィッティングが終了すると結果ウィンドウが出てくる

色＝フィッティングの良し悪し（緑＞黄＞赤 とフィッティ
ング結果が悪くなるにつれて連続的に色が変化する）

           
       






i idataidata

itheoryidataitheoryidata

RR

RRRR
R

22

22

ReIm

ReIm

cc

cccc

フィッティング結果

*数値の目安

amp (S02): 0.70 - 1.10

enot (E, e0): < 10 eV

ss (s2)     : 0.003 - 0.020 Å2



⑤ フィッティング実行

フィッティングの結果をグラフ上で見る

フィッティング結果をプロット



⑤ フィッティング実行

第二配位圏のGa-Ga結合も考慮したフィッティングをかけてみる

Ga-Ga結合を選択

Ga-Ga結合に関する変数を新たに作成・登録



⑤ フィッティング実行

第二配位圏のGa-Ga結合も考慮したフィッティングをかけてみる

Include path, Plot after fitに☑

Ga-Ga結合を含むようにフィッティングの範囲を拡大する



⑤ フィッティング実行

いよいよフィッティング！

その前に、保存！！

第二配位圏のGa-Ga結合も考慮したフィッティングをかけてみる

R を選択

フィッティングを実行



⑤ フィッティング実行

フィッティングが終了すると結果ウィンドウが出てくる



⑤ フィッティング実行

フィッティングの結果をグラフ上で見る

フィッティング結果をプロット

この結果を .txt で保存したい時は？



⑤ フィッティング実行

フィッティングの結果を .txt で保存する

Save next plot to a file

を左クリックしてから

保存したいプロットを

選択



⑤ フィッティング実行

過去のフィッティングの結果を見る

History を左クリック

過去のフィッティング結果を選択

保存もできる



EXAFS解析の流れ

Artemis立ち上げ

① Athenaデータ読み込み

② 構造モデルの作成(Atoms)

モデル作成に必要な情報

・吸収元素の種類、吸収端

・結晶構造パラメータ（空間群、座標等）

③ EXAFSの理論計算（FEFF）

・Artemisに予め組み込まれている

④ フィッティングパラメータの作成

⑤ フィッティング実行

Athenaでデータ処理しておく！

・Background、Baselineの処理

・c(k)(EXAFS振動)の抽出

・c(k)をFT-EXAFSに変換

Atoms: FEFFの実行ファイルを

作成するためのプロフラム

.cif ファイルを入手しておくと

モデル作成の手間が幾分省ける

FEFF: 光電子の散乱過程と

散乱強度を計算するための

プログラム

⑦ 解析結果の保存

⑥ 束縛条件下でのフィッティング



⑥ 束縛条件下でのフィッティング

変数に制限をかけてフィッティングをかけてみる

(case 1) Ga-N結合、Ga-Ga結合の距離を格子定数から算出し、定数として扱う

・FEFFでは、格子定数から距離 R を計算

・フィッティングでは R からの変位 Δr のみを最適化

Δ r (= delr) を guess から set パラメータに変更し、’’0’’ として扱えばよい



⑥ 束縛条件下でのフィッティング

変数に制限をかけてフィッティングをかけてみる

(case 2) 結晶構造（対称性）から、Ga-Ga結合は、Ga-N結合の1.633倍長い

・FEFFでは、格子定数から距離 R を計算

・フィッティングでは R からの変位 Δr のみを最適化

R(Ga-Ga) = 1.633*R(Ga-N)

R(Ga-Ga) + Δ r (Ga-Ga) = 1.633*R(Ga-N)+ 1.633*Δ r (Ga-N)

→ Δ r (Ga-Ga) = 1.633*Δ r (Ga-N)

delr_2 を guess から def パラメータに変更し、’’1.633*delr’’ とすればよい



⑥ 束縛条件下でのフィッティング

変数に制限をかけてフィッティングをかけてみる

(case 3) amp を 0.8~1.0 の間に収まるようにフィッティングする。

Amp 上で右クリック→Build restraint from amp を選択



⑥ 束縛条件下でのフィッティング

変数に制限をかけてフィッティングをかけてみる

(case 3) amp を 0.8~1.0 の間に収まるようにフィッティングする。

数値の制限を指定するウィンドウが出てくる

Scale by : 1000 デフォルトのままで OK

Lower bound : 数値の下限

Upper bound : 数値の上限

Make restraint で確定する

制限パラメータ restrain が追加される



EXAFS解析の流れ

Artemis立ち上げ

① Athenaデータ読み込み

② 構造モデルの作成(Atoms)

モデル作成に必要な情報

・吸収元素の種類、吸収端

・結晶構造パラメータ（空間群、座標等）

③ EXAFSの理論計算（FEFF）

・Artemisに予め組み込まれている

④ フィッティングパラメータの作成

⑤ フィッティング実行

⑥ モデル妥当性の検証

Athenaでデータ処理しておく！

・Background、Baselineの処理

・c(k)(EXAFS振動)の抽出

・c(k)をFT-EXAFSに変換

Atoms: FEFFの実行ファイルを

作成するためのプロフラム

.cif ファイルを入手しておくと

モデル作成の手間が幾分省ける

FEFF: 光電子の散乱過程と

散乱強度を計算するための

プログラム

⑦ 解析結果の保存



⑦ 解析結果の保存

Save

Artemisのプロジェクトファイル保存

こまめに保存することをおすすめします



QFS（Quick-First-Shell Fit）

第１配位圏のみを解析するのに便利

Athenaからデータインポートするまでは同じ



QFS（Quick-First-Shell Fit）

第１配位圏のみを解析するのに便利

Athenaからのデータインポートするまでは同じ

Ga K-edge のデータ 第１配位圏は、Ga-N結合なので
N に変える

予想される結合距離に変更する

Ga-N の場合は、2.0 

フィッティングパラメータを自動的に作成し、登録する



QFS（Quick-First-Shell Fit）

パラメータを自動生成・登録

N（配位数）は自分で変える



Html版マニュアル
http://cars9.uchicago.edu/~ravel/software/doc/Artemis/Artemis.html
各種参考情報

http://xafs.org/Tutorials
特にShelly D. Kelly 氏(Argonne Natl. Lab.) のAthenaとArtemisに関するtutorial

http://xafs.org/Tutorials?action=AttachFile&do=get&target=Basics_of_XAFS_to_chi.pdf
http://xafs.org/Tutorials?action=AttachFile&do=get&target=Basics_of_XAFS_analysis.pdf

Iffefitのメーリングリスト（Iffefit, Athena, Artemisの開発者から回答してもらえる）
http://millenia.cars.aps.anl.gov/mailman/listinfo/ifeffit/
メーリングリストのアーカイブ（過去に同様な質問がされていないかどうか確認しておく）

http://millenia.cars.aps.anl.gov/pipermail/ifeffit/

付録1：マニュアル・参考情報

http://cars9.uchicago.edu/~ravel/software/doc/Artemis/artemis.html
http://xafs.org/Tutorials
http://xafs.org/Tutorials?action=AttachFile&do=get&target=Basics_of_XAFS_to_chi.pdf
http://xafs.org/Tutorials?action=AttachFile&do=get&target=Basics_of_XAFS_analysis.pdf
http://millenia.cars.aps.anl.gov/mailman/listinfo/ifeffit/
http://millenia.cars.aps.anl.gov/pipermail/ifeffit/


● ICSD (Inroganic Crysta Structure Database)
http://icsd.ill.eu/icsd/index.php

● NIMS物質・材料データベース
http://mits.nims.go.jp/
ユーザー登録が必要(無料)

● The Atoms.inp Archive
http://cars9.uchicago.edu/~newville/adb/search.html
ATOMS on the Webとリンクし、feff.inpファイルの取得が

可能

付録２：結晶構造データベース



付録３：モデルの三次元可視化による確認
(可視化プログラム利用)

プログラム起動

ここでは可視化プログラムの一つとしてVESTAを利用する。
(http://jp-minerals.org/vesta/jp/)

メニューから File －Open を選択



付録４：atoms.inpをインターネット上で作成

http://cars9.uchicago.edu/~ravel/software/

文献などから既知の
結晶構造を入力

WebATOMSをクリック

ATOMS database をクリック



atoms.inpをインターネットから
ダウンロード

① 目的の元素をクリック

②目的の物質を探し出してチェッ
ク ③ Get Atoms.inpを

クリック


